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iD44 delivers the audio performance of 
a large format console in a compact and 
elegant desktop package. 

iD44 provides four world-class Audient 
console mic pres, class leading converter 
technology, console style monitor 
control, JFET D.I and the revolutionary 
ScrollControl.

With its versatile feature set and intuitive 
layout, iD44 will become the hub of your 
studio in no time.

Features include:

• 4-in, 8-out high performance    
AD/DA converters

• 4 x Class-A Audient Console Mic        
Preamplifiers & 2 x discrete JFET         
instrument inputs.

• 2 x Independant Class-AB 
Headphones outputs

• Full Monitor Control Functionality 
(software controlled)

• iD Scroll Control Mode

• 2 x ADAT inputs  and 2 x ADAT outputs 
for up to 16 channels of Digital I/O 

• Word Clock output

• USB2.0 class compliant connectivity  
with integrated Low Latency DSP 
mixer

Thank you for purchasing
this Audient product!

Welcome and Thank You
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In your iD44 packaging you should find 
the following items:

• iD44
• 12VDC PSU with regional adapters
• USB Type C Cable
• USB Type C to Type A Cable
• Quick Start Guide

Please visit:
www.audient.com/products/iD44
to download the latest iD software 
(mixer application and drivers), 
supporting documentation (including 
this manual) and brochures for our 
product range.

The 12VDC power supply comes 
with interchangeable  UK, EU, US and 
Australian socket adapters and will work 
across a broad range of line voltages 
making iD44 globally portable.

We hope that you enjoy using iD44!

Box Contents and Setup
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! WARNING !
TO REDUCE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS 

APPARATUS TO RAIN OR MOISTURE.

NO USER SERVICEABLE PARTS INSIDE. 

PLEASE REFER SERVICING TO  QUALIFIED SERVICE PERSONNEL.

Important Safety Instructions

Please read all of these instructions and save them for later reference before connecting
the DC power adapter to the mains and powering up iD44.

To prevent electrical shock and fire hazard follow all instructions on the 12VDC power 
supply. iD44 itself does not operate with any high voltage mains supply inside the unit 
but appropriate safety measures should still be adhered to regarding the AC/DC supply.

Please ensure you only use the supplied iD44 power supply. We cannot recommend 
the useage  of third party power supplies. In the event of a power supply failure do not 
open the 12VDC supply. If required, please contact Audient support so that a suitable 
repacment can be sourced. 

audient.com/support

iD44 utilises an external switch-mode power supply that is very quiet and rated at 2A. 
This switch-mode design will accept any A.C line voltage from 90v to 264v @ 47-63Hz. 
Therefore the unit will work anywhere in the world but please ensure your A.C mains line 
voltage is within this specification.

Consult a qualified technician if you suspect difficulties. Do not attempt to tamper 
with the power supply or mains voltages - HAZARDOUS TO HEALTH. Ensure that the 
appropriate international pin adapter is fitted to the power supply before insertion into 
the mains socket.

Safety Information
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Important Safety Instructions

1.  Read these instructions
2.  Keep these instructions
3.  Heed all warnings
4.  Follow all instructions
5.  Do not use this equipment near water
6.  Clean only with dry cloth
7.  Do not install near any heat sources such as radiators, heat registers, stoves, or            

 other  equipment (including amplifiers) that produce heat
8.  Do not defeat the safety purpose of the polarized or grounding-type plug. A  

 polaized plug has two blades with one wider than the other. A grounding type  
 plug has two  blades and a third grounding prong. The wide blade or the third  
 prong are provided for your safety. If the provided plug does not fit into your  
 outlet, cosult an electrician for replacement of the obsolete outlet

9.  Protect power cords from being walked on or pinched particularly at plugs,   
 convenience receptacles, and the point where they exit from the equipment  
 Only use attachments/accessories specified by the manufacturer

10. Unplug this equipment during lightning storms or when unused for long periods  
 of time

11. Refer all servicing to qualified service personnel. Servicing is required when the  
 equipment has been damaged in any way, such as power supply cord or plug  
 is  damaged, liquid has been spilled or objects have fallen into the equipment,  
 the equipment has been exposed to rain or moisture, does not operate normally,  
 or has been dropped

12. For products that are a mains powered device: The equipment shall not be                                            
 exposed to dripping or splashing and no objects filled with liquids (such as   
 vases) shall be placed on the equipment.

13. Under the influence of electrostatic phenomenon, the product may
 malfunction and require the user to power cycle the unit.

Safety Information
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  We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK, 
  01256 381944, declare under our sole responsibility that the product iD44 
  complies with Part 15 of FCC Rules. 

  Operation is subject to the following two conditions:

  1.  This device may not cause harmful interference,
  2.  This device must accept any interference received,

   including interference that may cause undesired operation

Audient Ltd has conformed where applicable, to the European Union’s Directive 
2002/95/EC on Restrictions of Hazardous Substances (RoHS) as well as the fol-
lowing sections of California law which refer to RoHS, namely sections 25214.10, 
25214.10.2, and 58012, Health and Safety Code; Section 42475.2, Public Resources

  We, Audient Ltd, declare that the product, the iD44, to which this declaration 
  relates, is in material conformity with the appropriate CE standards and directives
  for an audio product designed for consumer use.

FCC Part 15B

This apparatus has been tested and found to comply with the limits of a class-A digital 
device, pursuant to Part 15B of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interfer-
ence to radio communications. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

 1. Re-orient or relocate the receiving antenna
 2.  Increase the separation between the equipment and receiver
 3.  Connect the equipment into an outlet on a different circuit from that 
  to which the receiver is connected
 4. Consult the dealer or an experienced radio/TV technician for help

Declaration of Conformities
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12V DC
Power

USB Connection

System Requirements

• MacOS: 10.7.5 (Lion) or later
• Mac: Intel CPU, 1GB RAM Minimum

1. Download the Latest iD Software

Head to our website for the latest version 
of our iD Mixer:

Open the downloaded .dmg file. Now, 
drag the downloaded app into your 
application folder to install it.

2. Connect iD44

Using the USB cable provided, connect 
iD44 to your computer’s USB port.

audient.com/products /downloads/iD44

MacOS Installation
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3. Status LED

Once connected to your computer and 
powered on, the green status LED on iD44 
will illuminate.

If at any time the status LED turns off 
during normal operation please check 
all connections and if further problems 
develop please contact Audient support.

4. Double Checking Connectivity 

To ensure iD44 has been detected by your 
computer and correct clocking sources 
are set-up, navigate to:

Macintosh HD > Applications > 
System Preferences

Check that iD44 is set as your audio 
device. It’s recommended to disable 
system sounds.

It’s also worth checking Audio MIDI Setup
(found in Mac HD > Applications > 
Utilities).

Window > Show Audio Window

Here you should see iD44 report with 20 
inputs and 24 outputs. The clock source 
is configured in the iD app. See page 23 
for more details.

MacOS Installation
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Tip

Right click on the iD icon in the Dock 
and select Keep in Dock to have quick 
access to the iD mixer app at all times.

Menu/Task Bar Icons

On MacOS, the iD icon appears in the 
menu bar in the top right hand corner of 
the screen. This gives you quick access 
to various functions of the iD44. 

Show Mixer 

If the mixer window has been hidden, 
this  will bring it back to the forefront.

Quit

Fully closes the iD mixer application. 

About iD 

Displays information regarding 
the current version of the iD mixer 
application. 

Visit iD Knoweldge Base

Opens a browser windows for the 
Audient Helpdesk with helpful articles 
and FAQ’s.

 Check for Updates

The iD app will check with the Audient 
update server for any available firmware 
updates for iD44.

MacOS Installation



12

Windows System Requirements:

• Windows 7 or later (32 and 64 bit)
• Intel Core 2 @ 1.6 GHz, or AMD   

equivalent
• 1 GB RAM Minimum

1. Download the latest iD44 Software

Head to our website for the latest version 
of our iD Windows Installer:

audient.com/products/downloads/iD44

2. Connect iD44

Using the USB cable provided, connect 
iD44 to your computer’s USB port and 
connect the iD44’s power supply.

3. Run iD Mixer Setup

Double click on the installer to run the 
iD mixer setup and follow the on-screen 
instructions.

4. Reboot PC

Reboot your PC to make sure that the 
drivers have been installed.

Windows Installation
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4. Check Connectivity

The status LED will become solidly lit 
as soon as iD44 has achieved stable 
communication and should remain 
solidly lit during operation of the unit 
until power down. 

To double check the connection, go to 
PC sound settings by following:

PC Settings > Control Panel > Hardware 
and Sound > Sound

Here you can see whether iD44 is 
visible to the PC and you can make it 
the computers default sound device by 
pressing ‘Set Default’.

iD Icon

Once installed, the iD icon can be found 
in the Windows system tray (it may be in 
the hidden icons area):

• Double-click to open iD44 mixer 
window when iD44 is connected

• Right-click to quit or change sample 
rate and buffer size.

For mixing, a buffer size of 256 should be 
perfect. For tracking, experiement with 
lower buffer size values.

How powerful your computer is, and 
how processor hungry your project 
is, will affect how low you can get the 
buffer size settings before you get audio 
instability. 

Windows Installation
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Launch the iD Mixer Application

Launch the iD mixer application
by finding it in the following folder:

Macintosh HD > Applications > iD

Start > All Programs > Audient > iD

For more information on the mixer 
application feature set, please refer to 
page 17 of this manual onwards.

Check for Firmware Updates

If your computer is connected to the 
internet, the iD app will check for firmware 
updates  whenever a unit is connected. If 
there is a firmware update available then 
the iD app will notify you.

You can manual check for updates by 
going to the Help menu and selecting 
‘Check for Updates’. It will notify you if 
you’re on the latest version of firmware. 

Firmware Update

When there is a firmware update, you can 
select ‘From audient.com’ to download 
the latest version automatically (or select 
‘From file’ to install a local firmware file).

The latest version number will be 
retrieved from our servers and will be 
displayed (as shown above). Press next 
to continue with the firmware update. 
Press ‘update’ to install it. Once complete 
reboot iD44 using the power switch to 
apply it.

 

Mixer App & Firmware Update
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Hardware Features

Hardware Features
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Microphone Preamplifiers
& Line Inputs

iD44 features four classic Audient 
microphone preamplifiers. These 
preamps are based on designs from 
Audient’s classic  consoles and are the 
same that are used across our entire 
product range.

The design features discrete Class-A 
circuitry providing exceedingly low 
distortion and noise performance. From 
a sonic point of view, iD44 is fast, open 
and detailed.

NeutrikTM XLR/TRS Jack combi-
connectors provide microphone and 
line inputs. The line inputs are padded 
through the microphone preamplfiiers.

The four microphone preamplifiers 
feature:

• 60 dB of clean gain
• 48V (±4V) phantom power rated at 

14mA/channel
• >2.8kΩ input impedance which 

provides a punchy tone from any 
microphone      transducer type

• Signal and Clip Indicators
• -10dB Pad
• 100Hz High Pass Filter to remove 

unwanted rumble 
 
Channels 1 and 2 also include an 
Insert Send and Return allowing for 
the use of outboard equipment while 
tracking.

Hardware Features
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Instrument Input

iD44 employs 2 discrete Class-A JFET
instrument (D.I) inputs on channels one 
and two which are easily accessible on 
the front of the unit.

The JFET circuitry adds a tiny bit of colour 
and warmth to the signal, making it sound 
great on guitars and basses.

Plugging in a TS (tip-sleeve unbalanced)
jack will override the mic signal for that 
channel and turn it into a fully fledged, 
fantastic sounding instrument input with 
access to the Pad and High Pass Filters. 

Balanced Insert Send and Returns 

On Chennels 1 and 2, the iD44 features a 
dedicated insert to allow you to connect 
outboard gear to your recording chain; 
Just like the work flow you would find on 
an Audient console!

The two channels feature an impedance 
balanced send and an electronically  
balanaced return, all before the AD 
convertors. 

Insert your favourite EQ and compressor 
into the insert and with the super clean 
audient pre-amps, you can build vocal 
chains  that will rival the best out there! 

Insert Normalling

The Insert send and return jacks are half 
normalled meaning you don’t need to 
patch the two together when not in use. 
The internal signal chain is only broken 
when a jack is plugged into the return. 
Plugging a jack into the Insert send will 
split the signal which can be useful for 
parallel processing.

Hardware Features
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Direct Access to ADC

The Insert return connection on the iD44 
is a electronically balanced input stage 
that directly drives the analog to digital 
convertor for that channel. 

As such, this is a great place to input 
signals directly to the ADC, bypassing 
the pre-amplifiers and minimising any 
colouration of the signal.

This makes it useful to patch in external 
microphone pre-amplifiers without 
adding additonal colouration or noise. It 
is also handy for using the iD44’s outputs 
to drive external effects before returning 
them into your DAW using the insert 
returns.

Please note; the digital calibration level 
of the iD44’s ADC is 0dBFS = +18dBu.

Patching Inserts

To incorporate your favourite 
processing before conversion, 
simply patch the iD44 insert send 
into the first piece of gear in your 
processing chain. Then take the 
output of the last device in the chain 
and patch this into the iD44 insert 
return. 

Hardware Features
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When using 88.2kHz and 96kHz as a 
sample rate, you only have access to 8 
channels of digital input and 8 channels 
of digital output (due to the ADAT 
protocol).

More information on how the iD mixer is 
used to route to the optical outputs can 
be found on pages 36-37.

Word Clock Output

The iD44 also includes a BNC Word 
Clock output which allows you clock 
multiple digital devices to the iD44’s 
master clock and keep everything in 
sync.

The Word Clock output will send a clock 
signal at the same sample rate (44.1, 48, 
88.2 or 96kHz) that the iD44 is operating 
at. This will occur regardless of wheter 
the iD44 is being clocked internally or 
externally.

Clocking Configurations

When connecting external digital 
devices to the iD44, its important to 
ensure that all devices are syncronised.

Digital Inputs and Outputs

iD44 features two optical inputs and 
two optical outputs. These can be set to 
operate using optical stereo 
S/PDIF or 8-channel ADAT using the iD 
mixer application. All i/o will operate at 
up to 96kHz, with ADAT dropping to 4 
channels at sample rates of 88.2kHz or 
higher.

Running in S/PDIF mode, the optical i/o
provides the option to integrate external 
digital outboard, allowing upto 4 channels 
of audio in and out of the iD44 at sample 
rates up to 96KHz.

Running in ADAT mode, the optical i/o
provides a great way to expand to 20 
inputs for recording via an external mic 
preamp such as the Audient ASP800. 

The ADAT outputs could also be 
connected to headphone distribution 
systems such as a HearbackTM HUB 
or to an 8-channel DAC for summing 
purposes

Hardware Features
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To ensure this, one device in the setup 
must be set as the master clock. The 
other devices will then use the master 
clocks signal to stay in sync. There can 
only ever be one master clock present in 
a chain.   

The master clock signal can be sent 
either via an Optical cable embedded 
into the digital signal data, or through 
a BNC clock line cable. Please bear in 
mind that the clock will only travel in one 
direction through these conenctions, 
from a devices output to a devices input. 

Choosing a Master Clock

In a digital setup, there can be a number 
of options when determinging which 
device should be your master clock. 
Quite often the best device to set as the 
master is the one that is connected to 
the computer (where possible) such 
as an audio interface. This way, when 
you open a project in a DAW, the audio 
interface should change to match the 
project sample rate, and therefore 
change the sample rate of all the slave 
devices. However this depends on the 
devices being used.

iD44 as the Master Clock

With the iD44 set as the Master Clock 
the other devices in the chain can be 
clocked by either the Optical Port or the 
BNC word clock output. When clocking 
just one device, clocking via the optical 
port would be the simpliest option, 
simply connect the TOSlink cable up to 
the iD44’s optical output and to the other 
digital devices input.  

Then set the other device to Slave off the 
iD44’s clock. 

If you are using multiple devices then it 
is reccomended to use the BNC word 
clock output and then use T-connectors 
to Daisy Chain the Devices together. 
It is important to note that the final 
device in the chain should have its BNC 
connector terminated with 75 Ohms to 
stop reflections of the clock signal. This 
should be an switchable option on most 
devices.

Hardware Features
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iD44 with Single BNC Connection

Optical TOSlink Cable BNC Word Clock Cable

iD44 with Daisychained BNC connection

BNC T Connector

75 Ohm Terminiated

75 Ohm Terminiated

Hardware Features
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iD44 clocked via the Optical Port

iD44 as the Slave

The iD44 can also act as the slave to 
an external master clock via it’s optical 
inputs. The BNC connector is an output 
only.

In this case, you would simply connect 
the optical output of a device to the 
iD44’s optical input. Then, in the iD mixer 
application, select the optical input you 
wish to be used as the clock source. 
You would also need to set the inputs to 
either ADAT or S/PDIF depending on the 
specification of the external device.

More advanced clocking setups for the 
iD44 can be found at
 audient.com/support/iD44.

Hardware Features
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Neutrik

Neutrik

Neutrik

Neutrik

D.I 1

D.I 2

AUTO 
SENSE
 INPUT 
SELECT

+ 60dB

ADC

AUTO 
SENSE
 INPUT 
SELECT

+ 60dB

ADC

INSERT

INSERT

DIRECT 
MONITOR

PATH
(SOFTWARE 

CONTROLLED)

ADC

+ 60dB ADC

+ 60dB

CH1

CH2

CH3

CH4

OPTICAL
IN 1

OPTICAL
IN 2

Microphone Input
XLR Combi Female
Pin 1: Chassis Ground Pin
Pin 2:Hot (+ve)
Pin 3: Cold (-ve)
Input Impedance: >3k ohm
Maximum Input Level: +22 dBu

Line Input
1/4” TRS Combi Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Input Impedance: >10k ohm
Maximum Input Level: +32dBu

 

DI Input
1/4” TS Jack
Tip: Hot (+ve)
Sleeve: Ground
Input Impedance: >1Meg ohm

Insert Sends
1/4” TRS Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Output Impedance: >100 ohm
Maximum Output Level: +22 
dBu

Insert Return
1/4” TRS Jack
Tip: Hot (+ve)
Ring: Cold (-ve)
Sleeve: Chassis Ground
Input Impedance: >10k ohm
Maximum Input Level: +18 dBu
Digital Reference: 0dBFS = +18dBU

Optical Inputs
TOSLink Optical Connector
ADAT: 8 channels @ 48kHz
ADAT SMUX: 4 channels @ 96kHz
S/PDIF: 2 Channels @ All sample 
rates

Input Specs

Class A Mic Preamplifer, Inserts, A/D converters and
Optical Input Block Diagram

USB
OUT

Hardware Features
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Line Outputs

iD44 has four line outputs, these can be 
used for connecting monitors on the back 
panel in the form of balanced TRS jack 
connectors. The outputs are impedance 
balanced using the same topology as our 
flagship console, the ASP8024.

The outputs are fed from high quality 
DACs (Digital to Analogue Convertors) 
sending clean, linear audio  to your 
speakers, perfect for critical listening.

You can use these outputs for more 
than just speakers. If you want to use 
hardware outboard equipment, you 
can send out up to four mono, or two 
stereo signals from these outputs, This is 
configured in the iD mixer software.

In order to keep your audio noise free, 
we would reccomend against the use of 
unbalanced (TS, RCA.. etc) cables on the 
line outputs.

Headphone Output

iD44 features a two high current 
headphone amplifiers which are fed by 
seperate DAC’s and can be accessed 
from the headphone jack on the front of 
the unit.

These can be used instead of or 
alongside speakers to get an idea how 
your mix translates to headphones, or to 
provide artist headphone mixes

The headphone outputs can 
comfortably drive a wide range of 
headphone impedances meaning that 
you will get great sounding audio no 
matter what model of headphones you 
have.

Hardware Features
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Monitor Control

iD44 provides all of the excellent
monitor control functionality as found
on our consoles.

As such, it is possible to control main and
alternative loudspeaker volumes with
a perfectly matched stereo volume 
control on the main unit.

Accompanied by this monitor volume 
knob are permanently assigned 
hardware DIM & CUT switches. The level 
of DIM and ALT. loudspeaker trim can be 
adjusted in the iD mixer application.

Alongside these functions, three user
programmable ‘F’ keys provide access
to several useful monitoring features.

Monitor Control Features

• Volume control (perfectly matched)
• Alt. loudspeaker with programmable
level (assignable to an ‘F’ key)
• DIM with programmable level
• CUT
• Mono Sum (assignable to an ‘F’ key)
• Polarity reverse (assignable to an ‘F’ 
key)

By using polarity reverse and mono sum
it is possible to listen in sum or difference
(mid or side) modes. This provides an
excellent way to check mono 
compatibility and to also learn spatial 
tricks from your favourite reference 
material.

Hardware Features
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iD Button

The iD button switches iD44 into 
ScrollControl mode, allowing the 
encoder to be used as a scrollwheel 
for the computer. This gives you the 
ability to control plugin parameters and 
anything else that is scrollable. This 
works well for adding automation or 
setting parameters in a hands-on way.

To use ScrollControl, hover your mouse 
over whatever you want to control and 
rotate the encoder. 

ScrollControl may act slightly different 
on different plugins or DAWs depending 
on how they have been programmed 
to work with scrolling. If you find it is too 
sensitive or not sensitive enough, you 
can try adjust your computer scrolling 
speed.

Talkback

The iD44 can take a talkback signal from 
a variety of places. You can assign one 
of the 4 analogue or 16 digital inputs as 
your talkback channel. When tallback 
is activated, signal from that channel is 
sent through one of the Cue mixes to the 
artist(s).

You can source the talkback audio 
from another audio device connected 
to your computer such as the built-in 
microphone. This allows you to free up 
an input channel on your iD44 that would 
otherwise be taken up, great for big 
sessions. 

Details on how to set this up can be 
found in the ‘Software’ section of this 
manual.

Hardware Features
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Hardware Metering

The 8-segment hardware meters 
indicate playback level of the iD mixer 
app, so it is suggested that end users 
observe their DAW metering for input 
levels.

Status LED

The status LED indicates connection via
USB to your computer. A solidly 
lit light means that there is stable 
communication between iD44 and your 
computer.

Kensington Lock

For those who work in educational
establishments or in situations where 
your equipment is public facing and 
subject to possible theft opportunities, 
we have provideda Kensington lock hole 
to enable you to protect your iD44.

Hardware Features
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Software Features

Software Features
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Input Channels - Channel Types

The iD mixer application features three 
types of input channels:

• Mic Inputs 
These are the inputs where you will 
see the signal from the iD44’s four 
analogue inputs  

• Digital Inputs 
These are the inputs from the iD’s 
optical inputs. The number of digital 
inputs present on the iD mixer 
application depends on the digital 
input type (S/PDIF or ADAT) and the 
sample rate being used. 

• Daw Returns  
These are the signals being played 
back from your DAW.  The iD44 has 
8 Daw Return Channels allowing you 
set up multiple cue mixes or sends to 
hardware  outboard gear.

Using these three channel types, you 
can build up your main monitor mix and 
up to four additional cue mixes.

Its important to note that the iD mixer 
application only controls the monitoring 
of the iD44. Changes made to the iD 
mixer application won’t affect the level 
present in your DAW or audio software.

Software Features
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Channel
 Name

Phase Flip

Pan Control

Stereo 
Grouping

Mute

Solo

Fader

Meters

Channel Features

Channel Name
By double clicking on the name of the 
channel you can rename it to help you 
organsie your iD mixer application. You 
could name a channel ‘Kick’ or ‘Snare’ for 
example.

Phase Flip
Inverts the polarity of the signal by 
180° to stop phase cancellation. This is 
useful if you a micing the rear of a guitar 
amplifier or the underside of a snare 
drum.

Pan Control
Allows you to send the audio to the left, 
to the right or anywhere between on 
your Main Monitor Mix or Cue Mixes.

Stereo Grouping
Allows you to group two ajacent 
channels together into a stereo channel 
with a single fader controlling the level of 
both channels. When a channel is stereo 
grouped, the pans will automatically be 
set to far left and far right. 

Software Features
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Solo
The Solo button mutes all other channels 
other than the one that is currently solo’d. 
Multiple channels can be solo’d at one time.

Mute
The Mute button stops this channel from 
outputting audio whilst it is engaged.

Fader
The fader controls the amount of signal that 
is sent to currently selected mix. This can be 
set to anywhere between -inf dB to +6dB.

Meter
The meter shows the current signal level in 
dBFS.  Should the signal level exceed 0dBFS 
then the peak indicators will illuminate red to 
indicate a peak. The peak indicators can be 
turned off by clicking in them. You can also 
turn off all peak indicators using Alt + Click.
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Mix Selection

Cue Mix 
Name

Mix Solo

Cue Mix
Level

Channel 
Views

Monitor 
Controls

Mix 
Meters

Chronometer

Master Section Features
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Channel Features

Mix Selection
Clicking on one of mixes allows you to 
make changes to that mix. When a mix is 
selected, it expands to reveal additonal 
controls for that mix. 

Cue Mix Name
Double clicking on a Cue Mixes name 
allows you to rename the Cue Mix. If for 
example you were creating mixes for four 
seperate band members, you could name 
them ‘Drummer’, ‘Guitarist’, ‘Bassist’... etc.

Mix Solo
The Solo button allows you to audition 
each of the Cue mixes through your 
monitors. 

Mix level
The Mix level allows you to control the 
overall level of the Cue mix that is sent to 
the outputs.

Mix Meters
The Mix meters show the master signal 
level of the selected Mix. 

Chronometer
The Histogram Meters allow you to see 
not only the current signal level but 
also the signal level from a few seconds 
previously.

This can be great to track down a sudden 
loud tranisent on a particular cue mix or 
to monitor the change in level over time 
as you make changes to a mix.

Channel Views
These three buttons allow you control 
which of the three channel types are 
shown in the mixer. If for example you 
weren’t using the digital inputs for a 
particular project, you can simply hide 
the optical channels by clicking on the 
OPT control.

Monitor Controls
These six buttons control various 
aspects of the iD44’s monitor controller 
capability. The function of each control 
can be found below:

• TB (Talkback) 
The talkback button switches 
talkback on and off. More information 
regarding talkback  and its various 
settings can be found in the ‘System 
Panel’ sectin of this manual. 
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• ø (Phase Flip) 
Pressing this switch flips the phase 
of one side of the stereo field. Used 
in conjunction with the mono button, 
this can be a great way to remove 
centred elements from a mix. in order 
to hear the hidden elements of a mix. 

• Mono 
The mono button sums the stereo 
outputs down to mono. This can 
be used to quickly check the 
mono compatability of your mix to 
make sure it’ll sound great almost 
anywhere! 

• Alt 
Alt allows you to quickly switch your 
monitor path to a seconary set of 
monitors to let you check how your 
mix translates on various speakers.  
 
You can select which outputs the ALT. 
monitor control flips to in the System 
Panel  

• Dim 
Reduces the output level by a preset 
amount  which can be great if you 
get a call or need to quickly chat to 
someone during a session. 

 

• Cut 
The cut button cuts the signal to the 
monitors.  
 
All these controls can be controlled 
from the iD44 itself, either by 
assigning them to an F-Key, or using 
the dedicated Dim and Cut controls.

Assigning F-Keys

Various functions of the iD mixer 
application can be assigned to the 
Function Keys of the iD44 to allow you 
to quickly control your monitoring at the 
click of a button.

To assign a monitor control to an F-Key, 
simply right click on the control and 
select the F-Key.
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System Panel Features

Digital I/O Format

Allows you to select whether each 
optical input or output uses ADAT or 
S/PDIF digital format.

Prefered Clock Source

The Clock source can be selected from 
either the internal clock or one of the two 
optical inputs. More information about 
choosing a clock source can be found in 
the clocking section of this manual.

When using an external clock source the 
indicator beside the selector shows the 
current status of the clock on that input. 

• Red - No clock signal detected on 
input

• Amber - A clock signal is detected but 
at a different sample rate to iD44

• Green - A clock signal is detected and 
is at the correct sample rate. 

For an external clock source to be 
working correctly you would want the 
indicator to be green. If the indicator 
isn’t green, iD44 will default back to the 
internal clock until it detects a valid clock 
input

Mono Mode

When the iD44’s Mono feature is 
engaged this option controls whether 
the mono signal is sent to the left, right 
or both monitors. 

Dim Level

When the iD44’s dim button is pressed, 
this control defines how much the level 
is reduced by. 
 
Alt Speaker Level

This control defines the level drop/
boost when the iD44 is switched to ALT 
speaker mode. This is used to balance 
levels between different speaker brands 
or types. 

Output Routing Selection

Opens the routing matrix for either the 
Analogue Outputs, Digital Output 1, 
Digital Output 2 or the Talkback channel 
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Routing Matrix

The Routing Matrix allows you to control 
the audio source for each of the iD44’s 
outputs from the following options

• Main Mix - This takes signal from the 
Master Mix of the iD mixer. This is what 
is usually used for most standard 
playback. 

• Alt - This takes signal the Master Mix 
but only when the Alt speaker mode. 
is active. 

• Cue A, B , C, D - This takes signal from 
the four cue mixes which can be 
created using the iD mixer.  Please 
note that the hardware volume 
control does not affect these mixes 
and the Cue’s have sperate trims 
which can be adjusted when the 
cue mix is selected in the Main Mixer 
Window 

• DAW THRU - This allows you to route 
to outputs exactly as they would 
appear in your DAW. For example, 
if you set Analogue out 1+2 to DAW 
THRU, anything your DAW sends out 
to Outputs 1+2 will be sent directly to 
Analogue outputs 1+2.  
 
This is also applicable for the digital 
outputs. As an example, setting digital 
outputs 1+2 to DAW THRU would 
allow you to directly send audio to 
this output from your DAW by setting 
channels in your DAW to playback 
via outputs 9+10 (outputs 1-8 would 
be your the analog outputs).  Digital 
outputs 3+4 would be outputs 
11+12... and so on.  
 
This gives you numerous sends direct 
from your DAW, out via the optical 
outputs for adding outboard gear or 
for extensive foldback solutions. 
 
Please note that in DAW THRU, the 
channel in question will bypass any 
volume control and audio will be 
passed at full scale. If this output 
is sent to a set of monitors without 
inline attenuation, this may be very 
loud. The only exception to this is the 
headphone outouts where the volume 
control will still function.
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Talkback Source 
 
The Talkback source allows the 
talkback input  to be taken from on the 
iD44’s internal inputs or from a device 
connected to the host computer 
(Such as a built-in microphone or USB 
microphone)

When you select an input as your 
Talkback channel, the channel for this 
channel in the iD mixer will be changed 
to a talkback channel which will have a 
TB button in the centre. 

If using an external device, the talkback 
signal will appear on channel DAW 10 

Faders will only appear for these 
channels on the Cue mixes, not on the 
Main Mix.

Talkback Device

If an external device is selected then this 
allows you to select which connected 
device is used. 
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Saving & Loading Mixer Presets

To allow you to quickly setup your iD 
mixer during a session you can save and 
quickly load various presets. This is great 
if you are moving between recording 
scenarios quite often. 

Mixer presets can be saved and loaded 
in two ways:

• Using the File menu and selecting 
either Save or Open 

• Using standard keyboard shortcuts :  

Save:  Mac -     Cmd + S
  Windows -     Ctrl + S
Load:  Mac -     Cmd+ O
  Windows -     Ctrl + O

Saving a Preset.

To save a preset,  simply setup your 
mixer the way that you’d like to save. 
Then select File > Save as explained 
above.  The mixer window should then 
show the Save dialog.

Simply enter the name of your preset 
and press save.  

It is also possible to export your preset 
files in order to send them to friends or 
to simply save them within your DAW 
session files for easy recall later on. To do 
this, select Export Mixer Configuration at 
the base of the Save screen.

Loading a Mixer Configuration

To load a previously saved preset, select 
File > Open to bring up the Load screen. 

The previosuly saved configuration will 
appear in a list.  Select the configration 
you wish to use and click Load. 

You can also open a mixer configuration 
directly from your file by selecting Load 
From File. 
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Menu/Task Bar Icons

MacOS

On MacOS, the iD icon appears in the 
menu bar in the top right hand corner of 
the screen. This gives you quick access 
to various functions of the iD44. 

Quit

Fully closes the iD mixer application. 

About iD 

Displays information regarding 
the current version of the iD mixer 
application. 

Visit iD Knoweldge Base

Opens a browser windows for the 
Audient Helpdesk with helpful articles 
and FAQ’s.

 Check for Updates

The iD app will check with the Audient 
update server for any available firmware 
updates for iD44.
 
Windows

The Windows taskbar Icon has all the 
options of the MacOS menu bar icon but 
also includes some Windows Specific 
options 

Set Sample Rate

Sets the operating sample rate of iD44. 
44.1, 48, 88.2 and 96kHZ are the four 
options available.

Set ASIO Buffer Size

Sets the buffer size of the iD44 between 
16 and 8192 samples. Higher sizes will 
take processing load off your computer 
but will cause increased latency 
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Standalone Operation

When in standalone mode, the iD mixer 
settings are saved onto the iD44 itself 
so that a mixer setting can be instantly 
recalled as soon as the iD44 is powered 
on without having to connect the iD44 
to a computer.  This is great for setting 
up complex tracking setups in remote 
locations. 

To setup Standalone mode, first setup 
the iD mixer in the way that you wish to 
be saved onto your iD44. This includes 
your digital I/O settings, output routings 
and talkback settings in the System 
panel. 

Now navigate to the Setup menu and 
select Store Standalone State. The iD  
Mixers current configuration will then 
be saved onto the iD44 itself, ready to be 
recalled when the iD44 is next powered 
on.

Firmware Update

Occasionally, Audient will release a 
firmware update for the iD44 in order 
to address bugs, improve comaptibilty 
and add new features. Therefore you 
may wish to check occasionaly for any 
updates. 

This can be done by navigating to the 
Window menu and selecting Check for 
Updates.

 The iD mixer application will then check 
with our update server if any updates for 
the iD44 are currently available. If there 
are then you will prompted to install 
them onto the iD44. 

If you then click next, you’ll be prompted 
to stop any playback through the iD44. 
Click Update and the update will begin. 
The iD44 may turn off a number of times 
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during the process. Once the update 
has completed, fully reboot the iD44 by 
flicking the power switch off, waiting for 
a few seconds and then flicking it back 
on again.

Audient Helpdesk

If at any point you need assistance 
with your iD44, the Audient Help desk 
can be opened directly from the iD 
mixer. Open the Window Menu and 
select Visit Audient iD Knowledge 
Base. 

This will open a browser window for 
the Audient Help desk. Here you will 
find numerous articles to help you get 
your iD44 setup best for you.
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Keyboard Shortcut Index

To allow you to find all shortcuts for the 
mixer application in one place without 
having to go through each page of this 
manual please refer to this table:

Location  Mac   Windows  Description
  
Faders  Alt + Click  Alt + Click  Resets fader to unity gain (0 dB)
Pans   Alt + Click  Alt + Click  Resets pan pots to central
         position 
Solos   Cmd + Click Ctrl + Click  Clears all solos if clicking on a
         solo’d channel
         Overrides all other solos (for solo  
                    exclusive) if clicking on an unsolo’d  
         channel
Meters  Alt + Click  Alt + Click  Clicking on peak hold indicator  
         will clear all clip indicators
Mixer Screen Cmd + S  Ctrl + S  Save mixer configuration
   Cmd + O  Ctrl + O  Load mixer configuration
View Modes Cmd + 1  Ctrl + 1  View Mic/Line Inputs
   Cmd + 2  Ctrl + 2  View Optical (Digital) Inputs
   Cmd + 3  Ctrl + 3  View DAW Mix Inputs
   Cmd + 4  Ctrl + 4  View System Panel

Please check the iD44 page online at www.audient.com/products/iD44 
for the latest mixer application updates. 

More shortcuts may be added without notification.
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Operation with Pro Tools

Once iD44 has been successfully 
installed following the steps detailed 
in this manual, launch Pro Tools and 
ensure that a new session is created 
at the desired sample rate (if clocking 
internally) or at the rate of the clock 
source (if clocking externally).

If using Windows, make sure that 
you have set the correct latency and 
buffer size settings in the iD app before 
opening a project. Changing these 
settings will result in ProTools needing to 
restart.

Playback Engine

Go to Setup > Playback Engine... and 
ensure that iD44 is set as the active 
playback device. 

I/O Setup

Go to Setup > I/O... to label your inputs 
and outputs and ensure that iD44 
is correctly reporting 20-inputs and 
24-outputs to and from Pro Tools. Note 
that analogue outputs 1-8 are the DAW 
playback channels in the iD mixer and 
can either be routed through the iD 
mixer or hard-wired directly from Pro 
Tools to the physical outputs. 

For more Pro Tools information 
consult your Avid user manuals & 
documentation.

Pro Tools Setup
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Operation with Logic Pro

Once iD44 has been successfully 
installed following the steps detailed 
after page 6 of this manual, launch Logic 
Pro and check the following:

Logic Pro > Preferences > Audio

Ensure that iD44 is selected as the active
audio device and set the buffer size 
(to affect system latency). If you are 
experiencing issues with playback 
stability and CPU loading, try increasing 
the buffer size. This appears with 
“overload” errors and/or pops and clicks 
and distortion in the audio.

If you are using the iD mixer to monitor 
input signals while recording, be sure to 
disable Logic’s software monitoring to 
avoid phasing as the same source will be 
heard twice with a short delay between 
the low latency DSP signal and the 
delayed software monitoring signal.

Assigning I/O

All of iD44’s input and output channels 
will be available to Logic for routing. 
There are a total of 20-inputs and 
24-outputs reported from the driver.

You can rename input 
and output channels 
to whatever you wish 
using the I/O label
 function. This is a 
great way to keep 
things organised.

Mix > I/O Labels

Logic Pro X Setup
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Operation with Logic Pro

If you are using an external clock source
(ADAT or S/PDIF) to clock iD44, please 
ensure that your Logic Pro project is set 
to the same sample rate when recording 
and playingback in a session, otherwise 
things may sound a bit sharp or flat!

File > Project Settings > Audio

If you are using the internal clock in iD44,
setting the sample rate via Logic Pro will 
update the iD44 sample rate to follow 
your session.

There may be a slight pause as the 
system re-clocks. This is normal.

This can be verified in Audio MIDI Setup.

Macintosh HD > Applications > Utilities

For more Logic Pro information please 
consult your Apple user manuals & 
documentation.

Logic Pro Setup
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Operation with Cubase / Nuendo

Once iD44 has been successfully 
installed following the steps detailed 
after page 6 of this manual, launch 
Cubase or Nuendo and head straight for 
the Devices menu:

Devices > Device Setup...

Select VST Audio System in the devices 
menu.

Select Audient iD44 in the menu to 
ensure that Cubase / Nuendo addresses 
the iD44 device driver. You will be asked 
if this is OK, select ‘switch’.

Select Audient iD44 in the devices 
menu...

Here you will see the main iD44 
information, where clock sources
can be set as well as activating i/o ports.
Be sure to click Externally Clocked if 
clocking from another digital device via 
ADAT or SPDIF.

Cubase Setup
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Operation with Cubase / Nuendo

Buffer sizes can be set in the control 
panel
within the VST devices display. It is ideal 
to keep them quite high to reduce CPU 
loading if you use the iD mixer as the 
input monitoring device while recording.

I/O ports can be renamed in the device
panel such that they better represent 
what you connect to them (for example 
Main Monitors, Headphones). This is 
useful as any names chosen here will be 
those displayed when assigning i/o on 
track input/output channel routing.

Close the VST device setup panel and 
navigate to the VST connections panel:

Devices > VST Connections (F4)

Here you can ensure that all buses have 
been created in Cubase / Nuendo and 
therefore all ports are addressable in 
your session. Add new buses and assign 
them to the necessary i/o if required.

Bus types can be set (mono / stereo) and 
the VST control room section can also 
be used. For more information regarding 
set-up please consult your Steinberg 
user manuals and documentation.

Cubase Setup
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In the Live Audio Preference panel you 
can set an appropriate buffer size (this 
can be kept high if you are monitoring in-
put signals for recording via the iD mixer. 
Ensure that iD44 reports as a 20-in, 24-
out device to Live. 

If necessary you can limit the number of 
i/o channels reported as active inputs 
(from the driver) in Live by using the in-
put and output config tabs. 

This is an excellent feature to help re-
duce CPU loading if all channels are not 
required.

Operation with Ableton Live

Once iD44 has been successfully in-
stalled following the steps detailed after 
page 6 of this manual, launch Ableton 
Live and head straight to:

Live > Preferences

Here navigate to the Audio tab and make 
sure that iD44 is assigned as the play-
back device.

For more information about setting up 
audio i/o refer to your Ableton Live user 
manuals & documentation.

Ableton Live Setup
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Troubleshooting

• “The unit will not power on”

Double check that the 12V adaptor is 
properly connected and that the regional 
adaptor pins of the power supply are 
fully pushed into place. 

• “I get clicks and pops on DAW 
playback”

This is most likely to do with setting the 
buffer size too low for your computer. 
This can be caused by running very large 
projects with a lot of plugins and virtual 
instruments. Experiment with higher 
buffer sizes. Typically you want small 
buffer sizes for tracking or recording 
software synths to keep the latency low. 
However when mixing it is fine to set a 
slightly higher buffer size as latency is 
not so much of a problem.

• “When I connect to my computer,             
I cannot play any audio out from iD44”

Firstly double check that the USB cable 
connecting iD44 to your computer is
functional and attached at both ends.

Double check that iD44 is set as the 
active playback device in your DAW and 
computer:

System Preferences > Sound > Output 
Tab > Audient iD44  (OSX)

Control Panel > Hardware and Sound 
> Sound > Manage Audio Devices > 
Audient iD44  (Windows) 

Launch the iD mixer application to 
activate communication between your 
computer and iD44. This only needs 
to be done once straight after power 
up. Once iD44 is set to the operational 
state you desire, you can quit the iD 
application and it will continue to 
function as intended.

In the software mixer, locate the DAW 
channels by pressing the DAW view 
button and increase the level of DAW 
1+2 fader.

Troubleshooting
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Double check that an appropriate clock 
source is selected (Internal for master 
operation), ADAT or S/PDIF clock for 
external slave operation. Ensure that you 
see the correct sample rate displayed in 
the Format drop-down menu.

If you are using Windows, go to the iD 
icon in the system tray and right click 
on it. This will bring up some settings 
including sample rate. Alternatively you 
can alter these setting in the Setup tab of 
the iD app. 

Change the sample rate to match that of 
the external ADAT device and session.

Troubleshooting

• “I have clocking issues which include 
iD44 not locking to external ADAT 
or SPDIF devices or operating at 
the incorrect rate compared to my 
session”

If there is an issue with syncing of an 
external device, the Status LED in the 
System Panel will be red or yellow. If 
the status light is red then iD44 cannot 
detect a clock signal from an external 
device, and yellow if it can detect a signal 
at the wrong sample rate. 

To change sample rate in OSX go to 
Audio MIDI Setup found by navigating to 
the folder:

Macintosh HD > Applications > Utilities > 
Audio MIDI Setup

Ensure that Audient iD44 is seen as an 
audio device (Window Menu > Show 
Audio Window).

Troubleshooting
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Troubleshooting

• “How do I reset the iD mixer 
application to it’s default state?”

To reset the mixer application, quit the 
iD app completely, then navigate to the 
following folder and delete the state.xml 
file (it will replenish upon a fresh launch 
of the application)

Macintosh HD > User > Library > 
Application Support > Audient > iD > 
state.xml

(C:) > Users > yourusername > AppData 
> Roaming > Audient > iD > state.xml

Do not delete the parent folder as this 
will also contain your iD mixer presets.

• “How do I make sure I have the latest   
version of iD firmware/software?”

To check for the latest updates to the
iD desktop mixer application please visit:
www.audient.com/products/iD44 
download the package and install.

You will be made aware of firmware 
releases from the iD app when 
connected to the internet. Please refer 
to earlier in this user manual for more 
information regarding firmware update.

FAQs

For more information and bug support,
please search our online Help Centre 
which can be found here:

audient.com/support

For technical support please create 
a ticket in our online support system, 
which can also be found in the 
support section of our website 
(see link above).

 

Troubleshooting
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MICROPHONE PREAMPLIFIER: 
(measurement includes ADC signal path)

MIC GAIN:   0 to 60dB
LINE GAIN:   -10 to 50dB
PHANTOM POWER:   48V ±4V @ 10mA channel (12VDC only)
MIC EIN:    <-126.0 dBu
CMRR:    >80 dB @ 1kHz
MAXIMUM INPUT LEVEL:  +18 dBu (+28dBu with pad)
INPUT IMPEDANCE (Mic): 3k Ω balanced 
INPUT IMPEDANCE (Line):  10k Ω balanced
FREQUENCY RESPONSE: ±0.5 dB 10Hz to 65kHz 
CROSSTALK:   <-90 dBu @ 1kHz & 10kHz
THD+N @ 0dBu (1kHz):  <0.003% (-96dBu)
SNR:    96 dB

XLR COMBI FEMALE:  Pin 2 (Hot), Pin 3 (Cold) & Pin 1 (Shield)
1/4” TRS JACK:  Tip (Hot), Ring (Cold) & Sleeve (Shield)

HEADPHONE OUTPUT / (DAC 3 & 4:) 
(Measured under AES-17 at phones output)

MAXIMUM OUTPUT LEVEL:  +14 dBu (0 dBFS digital maximum) 
DIGITAL REFERENCE LEVEL: +14 dBu = 0 dBFS
OUTPUT IMPEDANCE:  <50 Ω unbalanced 
FREQUENCY RESPONSE:  ±0.5dB 10Hz to Fs/2
CROSSTALK:  <-110 dBu @ 1kHz & 10kHz 
THD+N @ -1dBFS (1kHz):  <0.0008% (-103 dB)
DYNAMIC RANGE:  124 dB un-weighted, 111 dB A-weighted
MAXIMUM LEVEL into 30 Ω:  +7.5 dBu 0.003% THD+N Power: 225mW
MAXIMUM LEVEL into 60 Ω:  +10.2 dBu 0.002% THD+N Power: 
210mW
MAXIMUM LEVEL into 600 Ω:  +14.2 dBu 0.001% THD+N Power: 54mW

1/4” TRS JACK:  Tip (Left), Ring (Right) & Sleeve (Shield)

D.I / INSTRUMENT INPUT: 
(Channel 1)

D.I GAIN:    0 to 60dB
MAXIMUM INPUT LEVEL:  +10 dBu 
INPUT IMPEDANCE:  1MegΩ unbalanced
FREQUENCY RESPONSE:  ±0.5 dB 10Hz to 50kHz 
THD+N @ 0dBu (1kHz):  <0.3%
SNR:    95 dB A-weighted

1/4” TS JACK:  Tip (Hot) & Sleeve (Shield)

ANALOGUE TO DIGITAL CONVERTER (ADC 1 & 2): 
(Measuredvia Insert Returns under AES-17)

MAXIMUM INPUT LEVEL: +18 dBu (0 dBFS digital maximum)
DIGITAL REFERENCE LEVEL: +18 dBu = 0 dBFS
INUT IMPEDANCE                             >10k Ω Balanced
FREQUENCY RESPONSE: ±0.5 dB 10Hz to Fs/2 (Nyquist)
CROSSTALK:  -115 dBu @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz): <0.0008% (-103dB dB)
DYNAMIC RANGE:  121 dB un-weighted

1/4” TRS JACK:  Tip (Hot), Ring (Cold) & Sleeve (Shield)

DIGITAL TO ANALOGUE CONVERTER (DAC 1 & 2): 
(Measured under AES-17 at line outputs 1 & 2)

MAXIMUM OUTPUT LEVEL:  +18 dBu (0 dBFS digital maximum)
DIGITAL REFERENCE LEVEL: +18 dBu = 0 dBFS
OUTPUT IMPEDANCE:  <100 Ω
FREQUENCY RESPONSE:  ±0.5 dB 10Hz to Fs/2 (Nyquist)
CROSSTALK:  <-118 dBu @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz):  <0.0006% (-104dB)
DYNAMIC RANGE:  124 dB un-weighted, 127 dB A-weighted
1/4” TRS JACK:  Tip (Hot), Ring (Cold) & Sleeve (Shield)

DIGITAL INPUT: 

16-CHANNEL ADAT:  44.1kHz to 48.0kHz 
8-CHANNEL ADAT:  88.2kHz to 96.0kHz SMUX
STEREO S/PDIF / TOSLINK: 44.1kHz to 96.0kHz (Stereo)

USB2.0 HIGH SPEED: 

No. of INPUT CHANNELS: 20 (4 Analogue, 16 Digital)
No. of OUTPUT CHANNELS: 24 (8 Analogue, 16 Digital)
CONNECTOR:                                      USB Type-C
INCLUDED CABLES:  1.5m USB 2.0 Type-C to USB Type-C
   1.5m USB 2.0 Type-C to USB Type-C

DSP MIXER LATENCY: ROUND TRIP (in-to-out)
   44.1kHz 0.677ms
   48.0kHz 0.625ms
   88.2kHz 0.354ms
   96.0kHz 0.323ms

Technical Specifications



55

174mm

276mm

51mm
69mm

191mm

Dimensions
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Warranty Statement

Your iD44 comes with a manufacturer’s warranty for one year (12 months) from the 
date of despatch to the end user.

The warranty covers faults due to defective materials used in manufacture and faulty 
workmanship only.

During the warranty period Audient will repair at its discretion or replace the faulty unit 
provided it is returned carriage paid to an authorised Audient service centre. We will not 
provide warranty repair if in our opinion the fault has resulted from unauthorised 
modification, misuse, negligence or accident.

We accept liability to repair or replace your iD44 as described above. We do not accept 
any additional liability. This warranty does not affect any legal rights you may have 
against the person who supplied this product - it is additional to those rights.

Warranty Limitations

This warranty does not cover damage resulting from accident or misuse. The warranty 
is void unless repairs are carried out by an authorised service centre. The warranty is 
void if the unit has been modified other than at the manufacturer’s instruction. The 
warranty does not cover components which have a limited life, and which are expected 
to be periodically replaced for optimal performance. We do not warrant that the unit 
shall operate in any other way than as described in this manual.

Tel: 0044 1256 381944
audient.com

Warranty
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Service Information

iD44 contains no user-serviceable components, please refer to qualified service 
personnel for diagnosis and repair. Your warranty will be void if you tamper with the 
device at component level. If you have any questions with regard to the repair, please 
contact Audient Ltd.

If your unit is in warranty, please contact your dealer directly for a repair or replacement 
(at the discretion of the dealer).

For out of warranty repairs, please contact Audient Ltd, after which a Return Materials 
Authorization (RMA) number will be assigned. This number will serve as a reference for 
you and helps facilitate and expedite the return process. When the unit is returned please 
include this RMA number along with a description of the fault inside the packaging box.

To request an RMA, access technical support & FAQs, ask for troubleshooting assistance 
or make an enquiry, please visit: www.audient.com/support

Service
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A  Amperes
ADAT  Alesis Digital Audio Tape
ADC  Analogue to Digital Converter
DAW  Digital Audio Workstation
ASP  Analogue Signal Processing
CPU  Central Processing Unit
CUE  Artist Headphone Mix
DAC  Digital to Analogue Converter
dB  Decibel
dBu  Decibel referenced to 0.775Vrms = 0 dBu
dBFS  Decibel Full Scale
DC  Direct Current
D.I  Direct Injection (Instrument Input)
DoC  Declaration of Conformity
DSP  Digital Signal Processing
EQ  Equaliser
FAQ  Frequently Asked Questions
FCC  Federal Communications Commission
GB  Gigabyte
GUI  Graphical User Interface
HPF  High Pass Filter
HV  High Voltage
i/o  Input / Output
JFET  Junction Field Effect Transistor
LED  Light Emitting Diode
RoHS  Restriction of Hazardous Substances
RAM  Random Access Memory
S/PDIF  Sony Philips Digital Interface Format
THD+N Total Harmonic Distortion + Noise
TRS  Tip Ring Sleeve (1/4” Jack Balanced)
TS  Tip Sleeve (1/4” Jack Unbalanced)
USB  Universal Serial Bus
V  Volts
XLR  Extra Live Return, Extremely Low Resistance, 
  Canon X Series, Latching, Resilient Rubber Compound... or make up your  
  own!

Glossary


